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ABSTRACT

The Project “INTERACTIVE IMAGE AND TEXT EDITING USING
NET” is an editor, by which we can edit both the picture and text at the same
time. In this, we can create the document with both picture and text. And also, we
have the option that can save the picture with the text in the same file or can save
the picture alone in the separate folder, even text is present in the document.

We can modify the existing picture and can save that modified picture in
various extensions such as .bmp, .jpeg, .tif, etc., We can modify the existing
picture by various options like rotating the image, cropping the image, etc., We
can view the information about a particular file or a particular directory such as
its creation date, its last modified date and its last accessed date. We can insert
the existing file into the document. We can save both text and the picture in .rtf
format.

This is implemented by using “MICROSOFT VISUAL STUDIO .NET —

VISUAL BASIC .NET”.
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LIST OF ABBREVIATIONS

S.No ABBREVIATION

1) SRS
2) BMP
3) JPEG
4 RTF
5) XML
6) CLR
7 CLS
8) BCL
9 MSIL
10) CcoM
11) DLL
12) API
13) TIF

EXPANSION
Software Requirement Specification
Bitmap
Joint Pictures Experts Group
Rich Text Format
eXtensible Markup Language
Common Language Runtime
Common Language Specifications
Base Class Library
Microsoft Intermediate Language
Component Object Model
Dynamic Link Library
Application Programming Interface
Tagged Image File

1.2 SYSTEM REQUIREMENTS:-
1.2.1 HARDWARE REQUIREMENTS:-

Processor :
Keyboard :
Mouse :
Monitor :
Hard Disk :
RAM

Pentium — IV ( 1.6 GHz)
102 Keys Keyboard
ScrollBar Mouse

15” SVGA Monitor

10GB ( Maximum )

128 MB RAM ( Minimum )

1.2.2 SOFTWARE REQUIREMENTS:-

Operating System
Software Used

Windows 98 and Higher Versions
Microsoft Visual Studio .NET 2003

1. INTRODUCTION
1.1 PROBLEM DESCRIPTION:-

The Project “INTERACTIVE IMAGE AND TEXT
EDITING USING .NET” is an editor, where we can edit both
the picture and text at the same time.

In this, we can create the document with both picture and
text. And also, we have the option that can save the picture with
the text in the same file or can save the picture alone in the
separate folder, even text is present in the document.

We can modify the existing picture and can save that modified
picture in various extensions such as .bmp, .jpeg, .tif, etc., We
can modify the existing picture by various options like rotating
the image, cropping the image, etc.,

We can view the information about a particular file or a
particular directory such as its creation date, its last modified date
and its last accessed date. We can insert the existing file into the
document. We can save both text and the picture in .rtf format.

This is implemented by using “MICROSOFT VISUAL
STUDIO .NET 2003 — VISUAL BASIC .NET”, which is going
to be discussed in Chapter 4.

2. EXISTING SYSTEM AND PROPOSED SYSTEM

2.1 EXISTING SYSTEM:-

At present, there are so many editors for text editing like MS —
Word and image editing like MS — Paint, Adobe Photoshop, etc., but,
we can’t edit text and image in the same editor. We can edit text and
image as user’s wish. The current text - editor has editing features like
aligning, cut, copy, paste, deleting un-necessary text, formatting font
styles, bullets and numbering, inserting tables, inserting pictures, etc.,
and the current image — editor has editing features like cropping the
portion of the picture that we want, rotating the image, etc., And there

are some limitations in those editors. Let us discuss those limitations.

2.2 LIMITATIONS OF EXISTING SYSTEM:-

» Editing text and image which are present in the same document
is not possible.

» Saving the picture in the separate file is not possible when the
picture is present along with the text.

» Viewing the information about the particular file and the
particular directory is not possible.

» Inserting any existing file into the document is not possible.

» Cascading and tile windows are not available.

» Text cannot be viewed with Background.

w



2.3 PROPOSED SYSTEM:-

The proposed system named, “INTERACTIVE IMAGE AND
TEXT EDITING USING .NET?”, overcomes the above limitations
which are discussed above. In this editor, the features like saving the
picture along with the text with .rtf extension, saving the picture alone

with .bmp, jpeg, .tif, etc.,

2.4 ADVANTAGES OF PROPOSED SYSTEM:-
> Editing text and image which are present in the same document
is possible.
» Saving the picture in the separate file is possible when the
picture is present along with the text.
» Viewing the information about the particular file and the
particular directory is possible.
Inserting any existing file into the document is possible.

Cascading and tile windows are available.

v V Vv

Text can be viewed with Background.

3.2 TESTING:-

Testing is done to detect the errors in the software. This
implies not only to the coding phase but to uncover errors introduced
in all the previous phases.

The following are the types of tests that were performed-

» Unit Testing:-

Each and every module is tested separately to check
if its intended functionality is met. Some unit testing
performed are,

1. Paralleling the application to independent sub task.

2. Checking for the transmission of the sub-task to its
destination system.

3. Receiving this task and examining whether correct
data is received.

4. Computing the received task.

5. Sending the computed result to the server.

6. In the server side, again combining the results from
various systems.

7. Converting the result to user required format.

> Integration Testing:-

It is the testing performed to detect errors on
interconnection between modules. Here, the process of
sub-dividing the task and then sending it to other system
for computing are combined for examining. The system
receiving the task has to perform functions like receiving

the allotted task, computing it and sending the result back

3. SYSTEM ANALYSIS

3.1 PROJECT PLAN:-

The requirement phase deals with the sequence of activities
in producing the Software Requirement Specification (SRS)
document. It must be ensured that all the requirements of the software
are elicited and analyzed. In other words the needs of the system are
identified.

In the problem analysis phase, the current system is
analyzed by study of the existing materials, and the changes to be
made in the proposed system are decided upon. A clear understanding
of the needs of the system must be framed. Analysis leads to actual
specification.

Designing aims at how to satisfy the needs of the system.
The different modules of the system and the interaction between these
modules to produce the desired functionality are identified. During
detailed design, the internal logic of each module and their
algorithmic design is specified. The major and important decisions are
made in this phase.

Coding is the process of translating the design into code.
The code developed must be easy to understand. Well-written code
can reduce testing and maintenance effort.

Testing is done to check if the requirements of the user are
met. It also involves in checking the functionality of each module as

per the design document.

in specified format. All these events when done together

must satisfy its purpose.

» System Testing:-
The system is tested against the system requirements
to see if all the requirements are met and if the system
performs as per the specified requirements. The system

is tested as a whole to check for its functionality.

> Validation Testing:-

This test is done to check for the validity of the
entered input. The input got is the size of the matrix.
Validation is done that without entering any value, the
next step cannot be proceeded. Then entered value must
be only numerals. If any character is entered an alert

message must be given to the user.



3.3 SOFTWARE REQUIREMENT SPECIFICATION:-

3.3.1 INTRODUCTION:-
3.3.1.1 PURPOSE:-

The purpose of this document is to specify the

requirements of project “Interactive Image and Text

Editing using .Net”. It is an editor by which we can edit

the text and image in the same document and can save

the text with the picture or separately. The document

also bridges the communication gap between the

customer and the analyst.

3.3.1.2 SCOPE:-

SRS forms the basics for agreement between the
client and the supplier and what the software product
will do. It also provides a reference for the validation of
the final project.

Any changes made to the SRS in the future will

have to go through formal change approval process.

3.3.2 DEFINITION:-
3.3.2.1 CUSTOMER:-
A person or organization, internal or external to
the producing organization, who takes financial
responsibility for the system. In a large system this may

not be the end user.

modify the existing picture and can save that modified
picture in varjous extensions such as .bmp, .jpeg, .tif,
etc., We can save both the text and the picture with .rtf

extension.

3.3.3.2 USER CHARACTERISTICS:-
The main users of the system are technically
knowledge person in the organization, enough to handle

the project requirements.

3.3.3.3 GENERAL CONSTRAINTS:-
The system will run only on windows platform (

Windows 98 and Higher Versions ).

3.3.4 SPECIFIC REQUIREMENTS:-
3.3.4.1 SOFTWARE CONSTRAINTS:-
The system runs on windows platform. Requires .Net
Framework Should be installed. At the same time, a large

number of users can use the application. -

3.3.2.2 USER :-

A person who will use the application that is

developed.

3.3.2.3 ANALYST :-
The Analyst details the specification of the
system's functionality by describing the requirements

aspect and other supporting software requirements.

3.3.2.4 ABBREVIATION:-
S.No  ABBREVIATION EXPANSION
1) SRS Software Requirement Specification
2) BMP Bitmap
3) JPEG Joint Pictures Experts Group
4) RTF Rich Text Format
5) TIF Tagged Image File Format

3.3.3 GENERAL DESCRIPTION:-
3.3.3.1 PRODUCT OVERVIEW:-

This is an editor, by which we can edit both the
picture and text at the same time. In this, we can create
the document with both picture and text. And also, we
have the option to save the picture with the text in the
same file or can save the picture alone in the separate

folder, even text is present in the document. We can

4. SOFTWARE STUDY
4.1 INTRODUCTION:-

NET is Microsoft’s platform for the next generation of
software that connects our world of information, devices and people in
a unified, personalized way. The .NET platform enables the creation
and use of various applications, processes and services that share and
combine information and functionality with each other by design, on
any platform or smart device, to provide tailored solutions for
organizations and individual people. .NET is a comprehensive family
of products, built on industry and Internet standards, that provide for
each aspect of developing (tools), managing (servers), using (building
block services and smart clients) and experiencing (rich user
experiences) XML Web services. .NET will become part of the
Microsoft applications, tools, and servers you already use today — as
well as new products that extend XML Web service capabilities to all

of your business needs.

4.2 WHAT IS MICROSOFT .NET:-

Microsoft is creating an advanced new generation of software
that melds computing and communications in a revolutionary new
way, offering every developer the tools they need to transform the
Web and every other aspect of the computing experience. This
initiative is called Microsoft .NET, and for the first time it enables
developers, businesses and consumers the ability to harness
technology on their terms. Microsoft .NET will allow the creation of

truly distributed Web Services that will integrate and collaborate with



a range of complementary services to serve customers. Microsoft
.NET will drive the Next Generation Internet. It will make information

available any time, any place and on any device.

4.3 MICROSOFT .NET PROGRAMMING MODEL.:-

The Microsoft NET programming model gives developers the
opportunity to focus fewer resources on where or how an application
runs and focus more resources on what the application does - where
they can add real value. Microsoft .NET addresses some of the biggest
challenges facing developers, particularly the tradeoff between
functionality and manageability. In addition, developers will be able
to leverage and customize a range of core Microsoft .NET building
block services in their own applications and services, reducing the
effort required to create compelling products.

Visual Studio.NET represents the complete development
environment for building applications on the Microsoft NET
platform. With Visual Studio.NET, developers can build Web
applications and XML Web services that render in any browser and
on virtually any device. By using the language of their choice,
developers can leverage their existing investments in skills and
systems. The result is increased productivity, end-to-end Web

development, and a shorter time to delivery.

4.5 THE IMPROVING TECHNOLOGY:-

Microsoft .NET supports high levels of integration with
existing infrastructures and applications. It provides new technologies
and evolves existing ones, enabling you to draw upon the existing
experience of your staff. It also uses your existing hardware and
supports scaling up and scaling out as your needs demand.

A key premise of Microsoft .NET is integrating applications.
As a result managing integration is critical to its success. By enabling
customers to better monitor and control their computing resources,
Microsoft is providing the basis for managing distributed computing
as an integral part of all Windows-hosted environments.

Microsoft .NET addresses most of today’s computing
deficiencies to realize the vision of enabling access to all user’s data
and applications anywhere and from any device; allowing users to
interact with their data through handwriting, speech, and vision

technologies.

Microsoft’s vision for this new generation of distributing
computing on the Internet is one where software is delivered as a
service, accessible by any device, any time, any place, and is fully
programmable and personalized. To enable this vision, Microsoft is
delivering the .NET platform and .NET experiences, built on public
Internet standards and protocols, with tools and services that integrate

computing and communications in productive new ways.

The Microsoft .NET platform is explicitly designed to enable
the rapid development and integration of any group of XML Web

services and applications into a single solution.

4.4 THE .NET PLATFORM:-
From a technology standpoint, .NET is the platform and the

NET experiences built on top of the platform. The platform includes:

» Tools — to build applications and XML Web services ( .NET
Framework and Visual Studio.NET).

» Servers — on which to build, host and deploy those
applications and services (Windows 2000 Server and the
NET Enterprise Servers).

» Services — a core set of NET building block services.

» Client software — the software that powers smart devices,
allowing users to interact and experience the NET platform.

> Experiences — the combination of the above components of
the .NET platform allow for more personal, integrated user

experiences -- .NET experiences.

User

; Server
Experiences Infrastructure

Building Block
Services

Developer
Tools

Fig 4.1. Core Components of NET

4.6 MICROSOFT .NET FRAMEWORK ARCHITECTURE:-
The core components of the NET Framework are described

below.

» The Common Language Runtime (CLR). The CLR
is the execution engine for NET Framework
applications. It provides a number of services including
the loading and execution of code, application memory
isolation, memory management, exception handling,
access to metadata (enhanced type information), and the
conversion of MSIL (Microsoft Intermediate Language)
to native platform code.

» The Base Class Library (BCL). The BCL provides an
extensive set of classes, logically grouped into
hierarchical namespaces that provide access to the
underlying features of the operating system.

» ADO.NET. This is an evolutionary update to the
ActiveX Data Objects (ADO) data access technology,
with  significant improvements aimed at the
disconnected nature of the Web.

» ASP.NET. This is an advanced version of Active
Server Pages (ASP) for Web application development
(using Web Forms) and Web service development.

» The Common Language Specification (CLS). This is
responsible for making many of the aforementioned

technologies available to all languages that support the



.NET Framework. The CLS itself is not a technology,
and there is no source code to it. It defines a set of rules
providing a contract that governs the interoperability
between language compilers and libraries.

» Win Forms. This programming model and control set
provide a robust architecture for Windows-based
application development.

» Visual Studio.NET. This delivers the tools allowing
you to exploit the framework’s features to create

concrete applications.

(LB ][+ || ca ][ Iseript Jfrd Party]

| CLS: Common Language Specification |

RSP.NET
g We_b WebForms WinForms Visual
ervices Studio
ADO.NET: HET
Data and XML
BCL: Base Clags Library I

CLR: Common Language Runtime |

Fig 4.2. Microsoft .Net Framework Architecture

classes of the .NET Framework (provided within the Base Class
Library or BCL) provide a unified, object-oriented, hierarchical,
extensible set of class libraries for developers to use. The NET
Framework unifies the disparate frameworks that we need to
work with today. As a result, you no longer have to learn
multiple frameworks to do our work. As a component
developer, we don’t have to decide what language to target, as
we can simply target the CLR, knowing that our work will be

accessible from all languages.

4.7.3 CROSS - LANGUAGE INTEROPERABILITY:-
Among the many strengths of NET is language
transparency. Whichever managed language we choose, we have
equal access to the platform. The .NET Framework enables
cross-language inheritance, error handling, and debugging. As a
developer, we can take advantage of the .NET platform using

your preferred language.
4.7.4 MULTI - PLATFORM DESIGN:-

.NET represents a new way of developing software for
Windows and potentially other platforms. .NET is not
inextricably tied to the Windows operating system. For example,
the intermediate code (MSIL) generated by .NET language
compilers, is not processor specific and the BCL classes are
designed to work on any operating system. .NET also allows your
application to easily span platforms because of its interoperability

and extensibility features.

4.7 FEATURES:-

4.7.1 COMMON LANGUAGE RUNTIME:-

The Common Language Runtime (CLR) plays a role in both
the development and execution of .NET applications. At runtime,
the CLR is responsible for managing the execution environment
of .NET (managed) code, including memory allocation and
thread management, as well as enforcing security policies.
Because the CLR automates these development tasks,
development time is reduced and development tasks are
simplified. Some of the key components of the CLR are shown in

Figure below.

Base Class Library Support

Type Checker | | Exception Manager

I |
| Thread Support | | COM Marshater |
| |
| |

Security Engine I | Debug Engine

MSIL to Hative Code Garbage
Compilers Manager Collector

| Class Loader I

Fig 4.3. Components of Common Language Runtime

4.7.2 MULTILANGUAGE AND EXTENSIBLE:-
The critical role of the runtime in the NET Framework
(and what really sets it apart) is that it provides a unified

environment across all programming languages. The base
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4.8 ADVANTAGES OF USING .NET FRAMEWORK:-

Here are some of the advantages provided by the .NET

Framework:

» Consistent programming model. All application
services are accessed through a common object-
oriented programming model, unlike today where
some operating system facilities are accessed via DLL
functions and other facilities are accessed via COM
objects.

> Simplified programming model. NET seeks to
greatly simplify the plumbing and arcane constructs
required by Win32 and COM.

> Run once, run always. All developers are familiar
with DLL Hell. Since installing components for a new
application can overwrite components of an old
application, the old application can exhibit strange
behavior or stop functioning altogether. The .NET
architecture now separates application components so
that an application always loads the components with
which it was built and tested. If the application runs
after installation, then the application should always
run.

> Execute on many platforms. Once written and
compiled to MSIL, a managed .NET application can
execute on any platform that supports the .NET CLR



(including non-Windows based platforms). You
immediately appreciate the value of this broad
execution model when you need to support multiple
computing hardware configurations or operating
systems.

Language integration. While COM allows different
programming languages to interoperate with one
another, .NET allows languages to be integrated with
one another. For example, it is possible to create a
class in C# that derives from a class implemented in
Visual Basic.NET. NET can enable this because it
defines and provides a Common Type System (CTS)
common to all .NET languages. The Microsoft
Common Language Specification (CLS) describes
what compiler vendors must do in order for their
languages to integrate with other languages. Microsoft
is providing several compilers that produce code
targeting the .NET CLR: C++ with Managed
Extensions, C#, Visual Basic.NET (which now
subsumes Visual Basic Scripting Edition and Visual
Basic for Applications (VBA)), and JScript. In
addition, companies other than Microsoft are
producing compilers for other languages that also
target the NET CLR.

Code reuse. Using the mechanisms just described,
you can create your own classes that offer services to

third-party applications. This of course, makes it
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is no way to construct an arbitrary reference to a
memory location and cause code at that location to
begin execution. Type safety and a lack of direct
pointer manipulation form the basis of the security
model, and they also eliminate many common
programming errors and classic system attacks such as
the exploitation of buffer overruns.

> Rich debugging support. Because the NET CLR is
the common basis for many languages, it is now much
easier to implement components in your application
developed using the language that's best suited for
each of them. The .NET CLR fully supports
debugging across components written in multiple
languages. For example, you can step into the source
code of a control written in C#, from a Visual
Basic.NET client program.

> Consistent error handling. One of the most
frustrating aspects of programming on the Windows
platform is the inconsistent way in which errors are
reported. Some functions return Win32 error codes,
some return HRESULTS, and some raise exceptions.
In NET, all errors are reported via exceptions.
Normal program execution stops when an exception
occurs, and an appropriate exception handler is
sought. Exceptions also allow you to isolate the error-
handling code from other program logic. This greatly

simplifies writing, reading, and maintaining code. In
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extremely simple to reuse code and broadens the
market for component vendors.

> Automatic resource management through garbage
collection. Programming requires great skill and
discipline. This is especially true when it comes to
managing resources such as files, memory, network
connections, database resources, and so on. One of the
most common types of bug occurs when an
application neglects to free one of these resources,
causing that application or another to fail. The NET
CLR  automatically  tracks resource  usage,
guaranteeing that your application never leaks
resources. This is called garbage collection. There is
no way to explicitly free a memory resource, as it is
automatically garbage collected when it is no longer
required.

> Type safety. The NET CLR can verify that all your
code is type safe. Type safety ensures that allocated
objects are always accessed in compatible ways.
Hence, if a method input parameter is declared as
accepting a 4-byte value, the CLR detects and traps
attempts to pass an 8-byte value using this parameter.
Similarly, if an object occupies 10 bytes in memory,
the application can't coerce this into a form that
allows more than 10 bytes to be read. Type safety also
means that execution flow will only transfer to well-

known locations (namely, method entry points). There
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addition, exceptions work across module and

language boundaries.
> Deployment. Today, Windows-based applications
can be incredibly difficult to install and deploy. There
are usually multiple files, registry settings, and
shortcuts that need to be created. In addition,
completely uninstalling an application is nearly
impossible.  With  Windows 2000, Microsoft
introduced the Windows Installer, a new installation
engine that helps with these issues, but it is still
possible that a company authoring a Microsoft
Installer Package may fail to do everything correctly.
NET seeks to completely overcome these issues.
NET components are not referenced in the registry,
and installing most .NET-based applications requires
no more than copying the files to a directory.
Uninstalling a .NET application is as easy as deleting
those files. Also, the CLR allows side-by-side
deployments where, for example, you can have two
versions of the same application running at the same
time on the same machine while you migrate your

users.
4.9 NAMESPACES IN .NET:-

The Base Class Library (BCL) is included in .NET as a base
framework assembly that contains many class definitions, where
each class exposes a feature of the underlying platform. Since

Microsoft defines hundreds of classes in the BCL, the library is

23



divided into namespaces that logically group related classes
together. For example, the System namespace contains the base
class, Object, from which all other classes ultimately derive. In
addition, the System namespace contains classes for exception
handling, garbage collection, console I/0, as well as a variety of
utility classes that perform type safe conversions, format data

types, generate random numbers, and perform various math

functions.
System.WinForms
System.Web yst
Seruicgs_ uk L Design ComponentModel
-Description -HTMLControls
Discovery WebControls n
-Protocols System.Drawing
Caching Security [ Drawing2D [ Printing |
Configuration | Sessi i | Text
System.Data System. XML
L:]mo i soL | XSLT I .__
esign SOLTypes XPath —I Ser
System
[Callections 10 Security Runtime
[Configuration HET ServiceProcess | «InteropServices|
Diagnostics Reflecti Text +R ing
|Globalizati Resources Threading +Seriali

Fig 4.4. Base Class Library Namespaces

To access any of the platform's features, you need to work
with the relevant classes defined within these namespaces. If you
want to customize the behavior of any system provided class, you

can simply derive your own class from it.
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We can freely pass data types to and from components
developed in other languages and inherit from base classes
developed in other languages. IntelliSense also works with any
component regardless of development language. Visual
Basic.NET supports ADO.NET for data access, the Windows
Forms programming model, multithreading and new and

improved wizards and designers.

Existing Visual Basic developers will benefit from learning
the new language constructs and features, allowing them to
develop more powerful and robust applications. However, we
don’t have to upgrade all of our code straight away, as Visual
Basic 6 code and Visual Basic .NET code will happily run side
by side. If we do choose to upgrade, COM Interoperability
services will greatly help with a phased transition, allowing you
to seamlessly use your existing components. Visual Basic .NET
also provides an Upgrade Wizard, which steps you through the
upgrade process and performs the necessary language syntax
changes when a Visual Basic 6 project is loaded.

The primary new features introduced by Visual Basic.NET
include:

> Inheritance. Through implementation inheritance,
classes can extend (or inherit from) an existing base
class. Visual Basic.NET (in common with all .NET
languages) only supports single inheritance, meaning

that we can only inherit from a single base class. The
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4.10 AUTOMATIC MEMORY MANAGEMENT:-

The .NET Framework advances the features of COM+
resulting in much higher developer productivity. For example, the
NET Framework introduces automatic memory management,
regardless of the programming language. It also provides you
with a single, unified programming framework that brings
together the best features of the Windows Foundation Classes,
the Microsoft Foundation Classes, the Visual Basic APIs, and
augments them with other capabilities including advanced data

access architecture.

The .NET Framework also uses the same underlying
component services that COM+ provides today, with features
such as transactions, queving, and object pooling. In future
versions, it will also provide a feature called partitioning. This
provides stronger process isolation and is designed for
application service providers. COM+ is the highest-performance,

most feature-rich set of application services available today.

4.11 VISUAL BASIC .NET:-

Based on the .NET Type System, Visual Basic.NET offers a
number of significant improvements over previous versions of
Visual Basic. The main ones relate to its support for the object
oriented notions of polymorphism, inheritance, and method and
operator overloading. Others come from its common foundation

with other languages provided by the CLS.
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new class can obtain the functionality and behavior of
the base class, and choose to adapt behavior where
appropriate. A derived class can also choose to
provide new behaviors, for example by implementing
new methods. To use implementation inheritance, you
declare the new class and use the Inherits keyword to
express which base class the new one derives from.
You then use the Overrides keyword to modify the
base class’ functionality where appropriate. Note that
a method that is capable of being overridden in a
derived class must be marked as Overridable in the

base class.

» Polymorphism. This is the ability to treat objects of
different class types in the same way. Traditionally,
we could achieve this in Visual Basic using interfaces.
While Visual Basic .NET still supports polymorphism
through interfaces, it can now also be achieved using
inheritance.

> Constructors. Constructors allow an object to be
created and initialized to an initial state in a single
operation. This alleviates the need to create an object,
and then call a separate method to initialize it. In
Visual Basic .NET, object constructors allow you to
pass values to an object as it is being created. This
simplifies coding and helps reduce errors when

working with objects.
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> Initializers. Initializers allow you to declare a
variable and provide it with an initial value in a single
line of code. This leads to smaller, simpler, more
maintainable code:

» Structured Error Handling. The NET CLR uses
exceptions to handle error conditions in a consistent
way, irrespective of the programming language you
use. Exceptions are responses to failure conditions
that can occur while an application is running, They
can either be generated by the NET runtime (system
exceptions) or can be created programmatically
(application  exceptions). Exceptions can be
propagated across language boundaries. For example,
a component written in C# could generate an
exception which could subsequently be caught and
handled by a client program developed with Visual
Basic.NET.

4.12 CONCLUSION:-

With .NET, the Internet more fully becomes a platform for
business. Microsoft .NET addresses most of today’s computing
deficiencies to realize the vision of enabling access to all user’s
data and applications anywhere and from any device; allowing
users to interact with their data through handwriting, speech, and
vision technologies. The Microsoft .NET platform is explicitly

designed to enable the rapid development and integration.
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> To view the preview of the document and to take printout

of the document.

5.2 EDIT FUNCTIONS:-
The Edit menu consists of the following functions,
> Cut, Copy and Paste the selected items in the document
including picture.
> Deleting the selected text in the document.
> Find the particular word in the document and replacing
the particular word by another word.

> To select all items in the document.

5.3 VIEW FUNCTIONS:-
The View menu consists of the following functions,
» To view the whole document in normal or in page view.
> To view the statusbar, toolbar, ruler and buttonbar.

» Zoom - in and Zoom - out facility.

5.4 INSERT FUNCTIONS:-
The Insert menu consists of the following functions,
> To insert an already created file into the document.
» To insert an image into the document.

> To insert page break.
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5. FEATURES OF THE EDITOR

The Project “INTERACTIVE IMAGE AND TEXT EDITING
USING .NET” is an editor, by which we can edit both the picture and
text at the same time. In this, we can create the document with both
picture and text.

And also, we have the option that can save the picture with the text in
the same file or can save the picture alone in the separate folder, even text
is present in the document. We can modify the existing picture and can
save that modified picture in various extensions such as .bmp, .jpeg, .tif,
etc.,

The functions that included in our project are as follows:-

> File Functions
Edit Functions
View Functions
Format Functions
Insert Functions
Table Functions

Window Functions

YV V.V V V V V

Information Functions

5.1 FILE FUNCTIONS:-
The File menu consists of all basic functions as follows,
» To create a new file.
» To open an already existing file.
» To save both the text and the picture with .rtf format and

other extensions.
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5.5 FORMAT FUNCTIONS:-
The Format menu consists of the following functions,

> To change the font style and color of the text ( both
backeolor and forecolor ), and to change the background
color of the document.

» To change the tab settings, paragraph settings including
line spacing, alignment options and bullet settings.

» To change the option whether the picture file can be
saved along with the document or as a separate file.

> To edit an image and save it in a separate file.

5.6 TABLE FUNCTIONS:-
The Table menu consists of the following functions,

» To insert and delete tables, selected rows and selected
columns.

» To select the whole table, necessary rows and necessary
columns.

> To view the gridlines of the table.

> To change the properties of the table such as changing

the background color, to change the line width and so on.

5.7 INFORMATION FUNCTIONS:-
The Information menu consists of the following function,
» To view the information about the particular file and
particular directory such as its created date, its last

modified date and its last accessed date.



5.8 WINDOW FUNCTIONS:-
The Window menu consists of the following functions,
» The child Windows can be viewed either in a cascade
manner or in a tiled manner.

» We can work at all the windows simultaneously.

5.9 EXTRA FEATURES:-

» The toolbar is placed with appropriate buttons to perform
file new, file open, file save, page preview, file print, cut,
copy, paste, undo, redo and find functions.

» The buttonbar is placed with appropriate buttons to
perform alignment operations, bulleting text, numbering
text, zooming in and out, to change the font style of the
text and font size of the text.

> The statusbar is placed with various panels to show the
current page number, line number in the page, the
character number in the line, zooming in and out status

and the indication of num and caps lock keys.

5.10 UNIQUE FEATURES OF THE EDITOR:-
> Editing text and image which are present in the same
document is possible.
» Saving the picture in the separate file is possible when
the picture is present along with the text.
» Viewing the information about the particular file and the
particular directory is possible.

» Inserting any existing file into the document is possible.
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6. SYSTEM TESTING AND IMPLEMENTATION
6.1 SYSTEM TESTING:-

The system testing deals with the process of testing the
system as a whole. This is done after the integration process. The
entire system is tested by moving through each module from top
to bottom. The verification and validation processes are then
carried out. The errors that occur at testing phase are eliminated
and a well functioning system is developed.

Test case design focuses on a set of techniques, which meets
all testing objectives which are mentioned below.

» Testing is a process of executing a program with the
intend of finding an error.

» A successful test is one that uncovers an as yet
undiscovered error.

Testing demonstrates that software functions work
according to specifications. In addition data collected from
testing provides a good indication of software reliability and
some indication of software quality as a whole. Testing results in
the deduction in the number of errors. Critical modules are tested

as early as possible. The following testings are carried out.

6.2 IMPLEMENTATION:-

The Implementation phase of software development is
concerned with translating design specification into source code.
The primary goal of implementation is to raise source code and
internal documentation so that conformance of the code to its

specification can be easily verified, and so that debugging, testing
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» Cascading and tile windows are available.

» Text can be viewed with Background.
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and modification are eased. This goal can be achieved by making
the source code as clear and straightforward as possible.
Simplicity, clarity and elegance are the hallmarks of good
programs; obscurity, cleverness and complexity are indication
inadequate design and misdirected thinking.

Source code clarity is enhanced by structured coding
techniques, by good coding style, by appropriate supporting
documents, by good internal comments and by the features
provided in modern programming languages.

The goal structured coding is to liberalize control flow
through a computed program so that the execution sequence
follows the sequence in which the code is written. The dynamic
structure of a program as it executes then resembles the static
structure of the written text. This enhances readability of code,
which eases understanding, debugging, testing, documentation
and modification of programs. It also facilitates formal
verification of programs. The structure coding techniques are as
follows:

> Single entry, Single exit constructs
> Efficiency considerations
» Data encapsulation

» Recursion



6.3 MAINTENANCE:-

Maintenance is the enigma of system development. It holds
the software industry captive typing up programming resources. It
could be described as the symmetric process of changing the
software that is already in operation. Software maintenance
involves keeping software interfaces simple and standard, paying
particular attention to troublesome modules, replacing faulty
components and generally planning to replace components that are
old, obsolete, faulty, or at risk for imminent failure.

There are several factors that require to be maintained. They
are,

» Hardware platforms change or become obsolete.

» Operating system change.

> Compiler change.

» Language standard’s change.

» Communication standard’s change.

> Graphical user interface change.

> Related application software package change.
Maintenance can be classified into

» Adaptive maintenance

» Perceptive maintenance

» Preventive maintenance

» Corrective maintenance
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7. FUTURE ENHANCEMENTS
7.1 FEATURES WHICH WE ARE PROVIDED:-

> Editing text and image which are present in the same
document is possible.

» Saving the picture in the separate file is possible when the
picture is present along with the text.

» Viewing the information about the particular file and the
particular directory is possible.

> Inserting any existing file into the document is possible.

> Cascading and tile windows are available.

> Text can be viewed with Background.

7.2 THE POSSIBLE FUTURE ENHANCEMENTS:-

» The image can also be drawn in the same document.

> The image — editing tools like cloning the image, merging
the image and changing the color of the image can also be
added in the future.

> The image can be edit in the same page of the document.

» Word Dictionary can also be included.

» Translation of English documents into other languages can

also be possible.
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6.3.1 ADAPTIVE MAINTENANCE:-
It deals with adapting software change in the
environment. It does not lead to changes in the system

functionality.

6.3.2 PERCEPTIVE MAINTENANCE:-

It mainly deals with accommodating new or changed
users requirements. It also includes activities to increase
the system performance or to enhance its user interface.
The objective” of perceptive maintenance should be to

prevent failures and optimize the software.

6.3.3 PREVENTIVE MAINTENANCE:-
Preventive maintenance concerns activities aimed at
increasing the system’s maintainability such as updating
documentation adding comments, improving modular

structure of the system.

6.3.4 CORRECTIVE MAINTENANCE:-
This deals with the repair of faults found. Some of the
major causes of maintenance problems are,
» Unstructured code
> Maintenance programmers having insufficient
knowledge of the system and on application

domain.
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8. CONCLUSION
Thus, an editor with the facilities like editing picture and text,
creating the document with both picture and text, saving the picture with
the text in the same file, saving the picture alone in the same folder,
modifying the existing picture by various options like rotating, cropping,
etc., is implemented by using “Microsoft Visual Studio .NET — Visual
Basic NET”.
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9. APPENDIX
APPENDIX — A :: SAMPLE CODE
CODE FOR IMAGE - EDITING:-

Private Sub mnuFileOpen_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
mnuFileOpen.Click

Open.InitialDirectory = "C:\"
Open.Filter = "All Image Formats
(*.boap;* jpg;* jpeg;*.gif * tif)" & _
"* bmp;*.jpg;* jpeg;* .gif; * tif|Bitmaps
(*.bmp)[*.bmp|" & _
"GIFs (*.gif)|*.gif JPEGs
(*jpe)l* jpe;* ipeg/ TIFs (* tif)* tif"
Open.FilterIndex = 1
If Open.ShowDialog() = DialogResult.OK Then
P1.Width = PICTUREBOX_WIDTH
P1.Height = PICTUREBOX_HEIGHT
P1.Image =Image FromFile(Open.FileName)
P1.SizeMode = PictureBoxSizeMode.Normal
optNormal.Checked = True
End If
End Sub

Private Sub mnuFileSave_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
mnuFileSave.Click

Save.InitialDirectory = "C:\"
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strtMsg = "Image successfully saved to
" & Save.FileName
End If
MessageBox.Show("Image successfully
saved to " & Save FileName, Me.Text,
MessageBoxButtons.OK,
MessageBoxIcon.Information)
End Sub

Private Function GetlmageFormat() As ImageFormat
Select Case Save FilterIndex

Case 1

Return ImageFormat.Bmp
Case 2

Return ImageFormat.Jpeg
Case 3

Return ImageFormat.Gif
Case Else

Return ImageFormat. Tiff

End Select

End Function

Private Sub mnuFileExit_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
mnuFileExit.Click

Me Hide()

End Sub
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Save.Filter = "Bitmap (*.bmp)|*.bmp"

If Save.ShowDialog() = DialogResult.OK Then
Dim strMsg As String
P1.Image.Save(Save.FileName)

strtMsg = "Image successfully saved
to " & Save.FileName

End If

MessageBox.Show("Image successfully saved
to " & _ Save.FileName, Me.Text, _

MessageBoxButtons.OK,MessageBoxIcon.Inform

ation)
End Sub

Private Sub mnuFileSaveAs_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
mnuFileSaveAs.Click

Save.InitialDirectory = "C:\"
Save.Filter = "Bitmap (*.bmp)|*.bmp|GIF
(*.gif)*.gif]" & _
"JPEG (*jpg)l* jpg;* jpeg|TIF
(*.tif)*uf
If Save.ShowDialog() =DialogResult.OK Then
Dim strMsg As String
P1.Image.Save(Save.FileName,

GetImageFormat())
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Private Sub cmdFit_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
emdFit.Click

grpSizeMode.Enabled = True
P1.Width = PICTUREBOX WIDTH
P1.Height = PICTUREBOX_HEIGHT
P1.SizeMode = PictureBoxSizeMode.StretchImage
optStretchImage.Checked = True
Fit()
End Sub
Private Sub Fit()
If P1.Image. Width < P1.Width And _
P1.Image.Height < P1.Height Then
If Not IsFitForZoomIn Then
P1.SizeMode =
PictureBoxSizeMode.CenterImage
End If
End If
Calculate AspectRatioAndSetDimensions()
End Sub

Private Function
CalculateAspectRatioAndSetDimensions() As Double
Dim ratio As Double
If P1.Image. Width > P1.Image.Height Then
ratio = P1.Image. Width / _

4



P1.Jmage.Height
P1.Height = CInt(CDbl(P1.Width) / ratio)
Else
ratio = P1.Image.Height / _
P1.Image.Width
P1.Width = CInt(CDbl(P1.Height) / ratio)
End If
Return ratio
End Function
Private Sub btnCrop_Click(ByVal sender As

System.Object, ByVal e As System.EventArgs) Handles
btnCrop.Click

If IsValidCropValues() Then
imgUndo = P1.Image
btnUndo.Enabled = True
Dim rec As New Rectangle(CInt(txtXCoord.Text),
Clnt(txtYCoord.Text), CInt{txtWidth. Text),
Clnt(txtHeight.Text))
Dim bmp As New Bitmap(Clnt(txtWidth.Text),
Clnt(txtHeight. Text))
Dim gr As Graphics =
Graphics.FromImage(bmpCropped)
gr.Drawlmage(P1.Image, 0, 0, rec,
GraphicsUnit.Pixel)
Pl.Image = bmp
End If
End Sub
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Private Sub btnUndo_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles btnUndo.Click
P1.Image = imgUndo
P1.Refresh()
btnUndo.Enabled = False
End Sub

Private Sub emdZoomlIn_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
cmdZoomIn.Click

If grpSizeMode.Enabled Then

P1.SizeMode = PictureBoxSizeMode.AutoSize

End If
erpSizeMode Enabled = False
cmdFit.Enabled = True

IsFitForZoomln = True

P1.SizeMode = PictureBoxSizeMode.StretchImage
Fit()

P1.Width = CInt(P1.Width * 1.25)
P1.Height = CInt(P1.Height * 1.25)
End Sub
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Private Sub cmdRotateLeft_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
cmdRotateLeft.Click
P1.Image. RotateFlip(RotateFlipType.Rotate2 70FlipNone)
Pl.Refresh()
End Sub

Private Sub cmdRotateRight Click(ByVal sender As

System.Object, ByVal e As System.EventArgs) Handles

cmdRotateRight.Click
P1.Image.RotateFlip(RotateFlipType.Rotate90FlipNone)
P1.Refresh()

End Sub

Private Sub binShowBox_Click(ByVal sender As

System.Object, ByVal e As System.EventArgs) Handles
btnShowBox.Click

If IsValidCropValues() Then
P1.Refresh(}
Dim recCropBox As New
Rectangle(Clnt(txtXCoord. Text), _
Clnt(txtYCoord.Text), CInt(txtWidth.Text),

Clnt(txtHeight. Text))
P1.CreateGraphics.DrawRectangle(Pens.Red,
recCropBox)
End If
End Sub
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Private Sub cmdZoomOut_Click(ByVal sender As
System.Object, ByVal e As System.EventArgs) Handles
emdZoomOut.Click

grpSizeMode.Enabled = False

cmdFit.Enabled = True

Fit()

P1.SizeMode = PictureBoxSizeMode.StretchImage

P1.Width = CInt(P1.Width / 1.25)
P1.Height = CInt(P1.Height / 1.25)
End Sub
Private Function IsValidCropValues() As Boolean
Dim objControl As Object
For Each objControl In grpCropping.Controls
If objControl.GetType.ToString =
"System. Windows.Forms. TextBox" Then
Dim txt As TextBox = CType(objControl, TextBox)
Dim ValidationMsg As String = _

txt.Tag. ToString & " must be a positive integer"

With txt
If Name = "txtXCoord" Or .Name =
"txtYCoord" Then
ValidationMsg &=" or zero."
Else
ValidationMsg &="."
End If
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If .Text.Trim = "" Then

MessageBox.Show(ValidationMsg,
Me.Text, _
MessageBoxButtons.OK, _
MessageBoxIcon.Error)
SelectAll()
Focus()
Return False
End If
If Not IsNumeric(.Text.Trim) Then

MessageBox.Show(ValidationMsg,
Me.Text,
MessageBoxButtons.OK, _
MessageBoxIcon.Error)
SelectAll()
Focus()
Return False
Else
Try
intVal = CInt(.Text.Trim)
If txt.Name = "txtXCoord" Or txt.Name =
"txtYCoord" Then

If intVal < 0 Then
48
.SelectAll()
Focus()
Return False
End Try
End If
End With
End If
Next
Return True

End Function
Private Sub SizeModeRadioButtons_CheckedChanged(ByVal
sender As Object, ByVal e As System EventArgs) Handles
optAutoSize.CheckedChanged,
optCenterImage.CheckedChanged,
optNormal.CheckedChanged,
optStretchImage.CheckedChanged
Dim opt As RadioButton = CType(sender, RadioButton)
Dim sm As PictureBoxSizeMode = CType(opt.Tag,
PictureBoxSizeMode)
If opt.Checked Then
P1.SizeMode = sm
If sm = PictureBoxSizeMode.AutoSize Then
cmdFit.Enabled = False
Else
cmdFit.Enabled = True
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MessageBox.Show(ValidationMsg,
Me.Text, _
MessageBoxButtons.OK, _
MessageBoxIcon.Error)
.SelectAll()
.Focus()
Return False

End If

Elself intVal <= 0 Then

MessageBox.Show(ValidationMsg,
Me.Text, _

MessageBoxButtons.OK, _
MessageBoxIcon.Error)
.SelectAll()
Focus()
Return False
End If
Catch Exp As Exception
MessageBox.Show("Value must be a

positive " & _

"integer.", Me.Text,
MessageBoxButtons.OK, _

MessageBoxIcon.Error)
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P1.Width = PICTUREBOX_WIDTH
P1.Height = PICTUREBOX_HEIGHT
End If
End If
End Sub



APPENDIX - B :: SAMPLE OUTPUT

2. CHILD WINDOW
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4. IMAGE - EDITING

3. SAVING THE IMAGE IN THE SEPARATE FILE
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5. TO VIEW THE INFORMATION ABOUT THE FILE 6. SAVING BOTH TEXT AND PICTURE IN THE FILE
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